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ユーザーマニュアルについて

1  ユーザーマニュアルについて

1.	ユーザーマニュアルは製品を使用する上で必要な操作手順と設定方法を説明しています。 

1.1 ユーザーマニュアルの重要性
ユーザーマニュアルは製品に必要な情報と製品の安全基準を説明しています。
	T 本製品を使用する方はユーザーマニュアルを全てお読みください。
	T 全ての説明、特に安全基準に必ず従ってください。

ユーザーマニュアルは製品を安全に適切な方法で使用するための重要な情報を記載して
います。
	T ユーザーマニュアルはいつでも確認出来る様、製品と共に保管してください。

	T 製品の貸し出しや、製品譲渡の際もユーザーマニュアルを製品と一緒にお渡しください。
	T ユーザーマニュアルを紛失、破損した際はNeutrik webサイトよりダウンロード可能です。(www.
neutrik.co.jp)

1.2 名称について
名称 説明
DPRO Adapter DPRO Adapter NA2-IO-DPROをDPROアダプターと表記します
Dante™ オーディオ
ネットワーキング(以
下Dante™)

Dante™ オーディオネットワーキング(以下Dante™);
Dante™ (Digital Audio Network Through Ethernet )はAudinate社(オー
ストラリア)によって開発されたネットワークプロトコルです。
Dante™ はレイヤー3 IPパケッ卜を使用し、標準的なイーサネット上におい
て非圧縮、多チャンネル、そして低レイテンシーのデジタルオーディオ伝送
を実現します。

PoE Power over Ethernet (パワーオーバーイーサネット);
ネットワーク上のLANケーブル経由で電源供給を行います。

周辺機器 DPROアダプターに接続可能なすべてのデバイス;
オーディオソース(トランスミッター)とオーディオシンク(レシーバー)

オーディオソース オーディオシグナルを送信するすべてのデバイス
オーディオシンク オーディオシグナルを受信するすべてのデバイス

例)スピーカー、音響システム{パワーアンプ、ミキサー等)
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1.3 記号について
安全な使用のため、またユーザーマニュアルをより分かりやすくお読みいただくため、注意事項、記
号、用語、略語を使用しています。以下の記号は安全に関連する項目ではありませんが、マニュアル
を分かりやすくお読みいただくための説明を示します。

	Oこの記号は操作上の必須条件を示します。各操作手順を行う前に指定の項目を行って下さい。
	�この記号は操作手順を示します。記載されている手順通りに操作を行ってください。
	�この記号は操作の結果、または製品の動作を示します。
	• 必須ではない項目はこの記号で示します。
2.	操作順序のある項目は数字で示します。
(1) イラスト内の位置を示します。

この記号は安全に正しく製品をご使用いただくために役立つ情報を示します。

1.3.1 イラスト内の記号について

記号 説明
イラスト内の場所を示す番号

順序のある操作手順
ユーザーマニュアルの手順通りに操作を行ってください。

 この項目はOS Xを使用している場合の手順です。
 この項目はWindowsを使用している場合の手順です。

1.4 対象
本ユーザーマニュアルはサウンドエンジニア、ミュージシャン、イベント技術に関わる方向けに作成さ
れています。

1

1
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2  安全にお使いいただくために

2.1 警告と注意事項
機器の機能説明の前に、特定の使用方法で起こり得る危険についての警告を説明します。
警告は以下の通り分類します。

w 注意
危険の恐れ!
「注意」の警告は軽い傷害が発生する危険性を示します。
T この警告に従わないと、軽い傷害が発生することがあります。

w 注記
製品破損の恐れ!
「注記」の警告は製品が破損する危険性を示します。
T この警告に従わないと、製品が破損することがあります。

2.2 警告記号
記号 注意

一般的な警告を示す記号

聴覚に関する警告を示す記号

2.3 重要な規制注意事項
本製品はFCC﻿Part15﻿Class-Bに準拠し、デジタル機器に関する規格に基づいた試験において要件
に適合する製品です。この規格は、一般家庭での設置において、有害な電波干渉を避けるために規
定されています。本製品は無線周波数帯域のエネルギーを発生、使用、また放射する場合があるた
め、取扱説明に従って設置、使用しない場合、無線通信に有害な電波干渉を引き起こすことがあり
ます。また、特定の設置方法に従っても干渉を起こさない保証はありません。本製品がラジオまたは
テレビの受信に有害な干渉を引き起こす場合(製品の電源をオン/オフにすることで確認することが
できます)、以下のいずれかの対策で干渉を解消することをお勧めします。

• 受信アンテナを別の方向に向ける、または別の場所に移す。
• 製品と受信機の設置距離を離す。
• 受信機を接続している回路と別の回路のコンセントに製品を接続する。
• 販売店または経験のあるラジオ/テレビ技術者に相談する。

w 注記
Neutrik社の認定の下以外での機器の改造、改変を行うとFCCの機器認証が無効になる恐れがあ
ります。
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2.3.1 基準適合

本製品はEU(欧州連合)加盟国の販売基準を満たすものに付けられるCE, EAC各基準の適合マーク
を取得しています。詳細はwww.neutrik.com/en/approvals-and-certificatesを参照してください。

2.4 安全上の重要な注意事項

DPROアダプターの破損を避ける為、以下の項目を守ってください。
	• 製品を水に浸さない。
	• 直射日光の当たる場所で使用しない。
	• ラジエーター、暖房機器、オーブン、コンロ等の熱を発する機器の近くに設置しない。
	• 製品の発熱を避けるため、機器を覆わない。
	• ポール、ステージ、机、家具等からの落下など、製品に衝撃を与えない。

修理について

	w 注記
不適切な修理による製品の破損について

DPROアダプターはお客様ご自身での修理はできません。お客様ご自身で製品の分解や修理をさ
れると製品が破損する可能性があります。
	T いかなる状況下でもお客様ご自身で製品を分解しないでください。
	T お客様ご自身で部品交換を行わないでください。
	T 修理の際は販売店へお問い合わせください。

取り扱いについて
	T DPROアダプターは周囲の環境に注意してご使用ください。
	T 異常の際は直ちに使用を中止してください。(落下、機器破損、水に濡れた、水没等)
	T 異常な動作をした場合、直ちにDPROアダプターと他の機器間の接続を止めてください。
	T ガス等の引火性、揮発性のある物の近くで使用しないでください。

2.5 使用目的
DPROアダプターはアナログライン/マイク、およびAES/EBU入力をDante™ に変換、またDante™ 
入力をアナログライン、およびAES/EBU出力に変換するためのデバイスです。

2.6 不適切な使用について
DPROアダプターは屋外、爆発する恐れがある環境での使用には適していません。
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1 2

3

4

3  コンポーネントとアクセサリー
DPROアダプターには以下のアクセサリー(別売り)があります。

番号 説明 Item no.

1 DPROアダプター(デバイス) NA2-IO-DPRO

2 マウントブラケット﻿(内容品:﻿ブラケット2個、ねじ2個、スペーサー2個) NA-MB-KIT

3 ラックパネル NRP1RU-2A

4 ラバープロテクション(取り外し可能、製品に標準装着) NA-RC
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4  製品情報

4.1 DPROアダプターとは?
DPROアダプターは、既存のアナログ機器をDanteネットワークに接続するために設計された2IN-
2OUTブレイクアウトボックスです。高品質のマイクプリアンプと、リダンダントセットアップ、またはデ
イジーチェーン接続用の2つのDanteポートを備え、オーディオパラメーターはDPRO Controller アプ
リより調整することができます。
ロック可能なすべてのコネクター、また取り外し可能なラバープロテクションとともに、厳しい条件
下において高い信頼性を確保します。別途用意されているブラケットやラックパネルを使用すると 
DPROアダプターをテーブルの下、フロアボックス、ラック、またトラスに取り付けることが可能です。

4.2 デバイス

81011 9

1 52 4 63 7

4.3 コネクター・LED
4.3.1 フロントパネル

1

2 番号 説明
1 メタルハウジング
2 ラバープロテクション(取り外し可能)
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番号 説明
1 インプットシグナル

インプットシグナルの状態を表します。
	• 緑、黄、または赤点灯:インプットシグナルがあ
り、それぞれの色は信号レベルを表します。詳し
くはページ15メーターバーをご覧ください。
	• 消灯:インプットシグナルがありません。

2 48V ファンタムパワーLED
ファンタムパワーの状態を表します。
	• 赤点灯:ファンタムパワーオン.
	• 消灯:ファンタムパワーオフ.

3 HPF/Pad LED
ハイパスフィルター、またはパッドの状態を表しま
す。
	• 赤点灯: パッドオン
	• 緑点灯: ハイパスフィルターオン
	• 赤と緑交互に点滅:パッド、ハイパスフィルター
オン

4 アウトプットミュート LED
アウトプットのミュート状態を表します。
	• 赤点灯: ミュート
	• 消灯: ミュート解除

番号 説明
5 システムLED

デバイスのシステムステータスを表します
	• 赤点灯: 起動中
	• 緑点灯: スタンバイ

6 インプットタイプLED
インプットモードを表します
	• 緑点灯: アナログモード
	• 赤点灯: デジタルモード

7 アウトプットタイプLED﻿
アウトプットモードを表します
	• 緑点灯: アナログモード
	• 赤点灯: デジタルモード

8 バランスXLRアウト 2
	• アナログラインもしくはデジタル出力

9 バランスXLRアウト 1
	• アナログライン出力

10 バランスXLRイン 2
	• アナログラインもしくはデジタル入力

11 バランスXLRイン 1
	• アナログライン入力

4.3.2 リアパネル

1 2 3

5 4

番号 説明
1 リセットボタン

	• すべての設定をリセットします。詳しくはページ
32 5.5.8 デバイスのリセットをご覧ください。

2 リンクLED
イーサネット接続の状態を表します。
	• 赤点灯: 接続が確立しています。
	• 消灯: 接続されていません。

3 アクティブ
データ送受信の状態を表します。
	• 緑点滅: データ送受信が行われています。
	• 消灯: データ送受信が行われていません。

番号 説明
4 セカンダリーネットワークポート

Dante®セカンダリーポート(リダンダントモード
時)、もしくはスルーポート(デイジーチェーンモー
ド時)、PoE入力対応。

5 プライマリーネットワークポート(RJ45)
Dante®プライマリーポート、PoE入力対応。
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4.3.3﻿﻿DPROのモード切替およびスイッチ操作

DPROアダプターは以下の通りに接続します。
• アナログ使用時:チャンネル1および2に接続します。(入出力とも共通)
• AES使用時:チャンネル2にのみ接続します。(入出力とも共通)

AES入出力は1つのケーブルで2つの信号を伝送しています。そのため、AES接続時はチャンネル1を使用できなく
なります。また、チャンネル1にアナログ信号、チャンネル2にAES信号を接続すると計3つの信号となってしまい、こ
れらを併せることはできません。この場合、チャンネル1のアナログ信号が優先されます(入出力共通)。

w 警告
聴覚障害の危険！
誤った接続をした場合、大きなノイズが発生する可能性があります。
T AES/EBU信号をアウトプットチャンネル１（ANA）に接続しないでください。
T アウトプットチャンネル1(ANA)に何も接続されていない場合、パワーアンプをはじめ、アナログデバイス
をアウトプットチャンネル2(AES)に接続しないでください。
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4.4 DPROコントローラー
DPROコントローラーはオーディオパラメーターの調整、ステータスモニター、プリセットの作成および呼び出しをするこ
とが可能です。このアプリはWindowsおよびMac上で動作します。（タブレット端末には対応しておりません）

4.4.1 DPROコントローラーの説明

アナログインプットおよびアウトプット

1

6

5

2

34

番号 説明
1 メニュー
2 デバイスステータス
3 アウトプット設定
4 インプット設定
5 Dante コントローラーとのリンク
6 接続中のデバイス

選択されたデバイスが緑のラインで表示されます。
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メニュー

メニュー オプション ショートカットキー 説明
File Create Preset Ctrl/Cmd + N 新規プリセットウィンドウを開きます。

Load Preset Ctrl/Cmd + L 作成したプリセットを呼び出します。
Save As Preset Ctrl/Cmd + S プリセットを.dap形式にてコンピューターに保存します。
Quit Windows: 

Alt + F4, Ctrl + Q
Mac: Cmd + Q

アプリを終了します。

Device Identify Device Ctrl/Cmd + I 選択したデバイスを識別するために、フロントパネルLEDを10秒
間点滅します。

Reset Device 選択したデバイスのすべての設定を消去します
About Device 選択したデバイスの情報が表示されます。

Network Settings ネットワーク設定ウィンドウを開きます。
Firmware Upgrade 選択したデバイスのファームウェアウィンドウを開きます。

	• インストールされているファームウェアバージョンの表示
	• ファームウェアアップグレード

Help About Software DPROコントローラーアプリおよびクレジット情報のウィンドウ
を開きます。

その他のソフトウェアの機能 / ショートカット

オプション / ファンクション ショートカット 説明
Fader Ctrl/Cmd + click on 

fader
フェーダを0に戻します。

デバイスステータス
デバイスステータスの一例。各LED、ステータスについて詳しくはページ9 4.3.１フロントパネルをご覧ください。

記号 説明
Identify device ボタン
識別するデバイスをクリックするとイン、アウト両方のXLR上のLEDが10秒間点滅します。
Settings ボタン
クリックすると Settings ウィンドウを開きます。
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インプットチャンネル

アナログインプット AESインプット: チャンネル1が無効になります。

記号 / ボタン
説明ノーマル アクティブ
MiC/Lineシグナルボタン
入力感度を選択します。
MIC: マイクレベル
LINE: ラインレベル

ハイパスフィルターボタン
ハイパスフィルターのオンオフを切り替えます。

+48V +48V ファンタムパワーボタン （MIC入力時のみ）
ファンタムパワーのオンオフを切り替えます。
PAD ボタン﻿
16dBアッテネーションのオンオフを切り替えます。
Link/Unlink ボタン
各チャンネル同士のリンク / 非リンクを切り替えます。
Gain （マイク入力時のみ）
入力感度を調整します。
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アナログアウトプット AESアウトプット: チャンネル1が無効になります。

アウトプットチャンネル

記号/ボタン 説明
ノーマル アクティブ

Mute ボタン
出力をミュートします。
Link/Unlink ボタン
各チャンネル同士のリンク / 非リンクを切り替えます。

メーターバー
レベルメーターはインプットおよびアウトプットで利用することができます。

3

2

1 番号 説明
1 赤:0dBFSから-3dBFS
2 黄:-3dBFSから-18dBFS
3 緑:-18dBFSから-∞

0

-50

-10

-5

-20

-30

-40

-60

-80

4
dBFS
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4.4.2 Create Preset ページ

プリセットを使用してデバイスの設定を保存することができます。またデバイスがなくてもプリセットを作成することもで
きます。プリセットはお使いのコンピューターに.dapファイルとして保存されます。

	• メニュー: File > Create Preset
	• ショートカット: Ctrl/Cmd + N

ボタン / 表記 説明
CANCEL プリセットを保存せずウィンドウを閉じます。
SAVE PRESET プリセットを.dap形式でコンピューターに保存します。
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ボタン / 表記 説明

Choose devices

1つもしくは複数のデバイスのプリセットを呼び出します。
Select all: リスト上すべてのデバイスを選択します。
Select none: リスト上すべてのデバイスを非選択にします。
  非選択
  選択

PRESET PREVIEW プリセットの設定のプレビュウィンドウが開きます。
CANCEL プリセットを呼び出さずウィンドウを閉じます。
LOAD PRESET 選択されたデバイスにプリセットを呼び出します。

4.4.3 Load Preset ページ

コンピューターにある.dapファイルをプリセットとして呼び出します。
	• メニュー: File > Load Preset
	• ショートカット: Ctrl/Cmd + L
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アイコン Description

警告アイコン
一致しない箇所が表示されます。

4.4.4 Load Preset Mismatch

プリセットとデバイスのモードが一致しない場合(例、プリセットはAESモード、デバイスはアナログモード)プリセットが
呼び出されません。モードについて詳しくはページ11 4.3.3 DPROのモードおよびスイッチ操作をご覧ください。
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4.4.5 Reset Devices ウィンドウ

この機能は選択したデバイスを工場出荷時の初期設定にリセットします。
リセットについて詳しくはページ32をご覧ください。

	• メニュー: Device > Reset Device

ボタン / 表記 説明
CANCEL デバイスをリセットせずにウィンドウを閉じます。
RESET DEVICES 選択したデバイスをリセットします。

Select all: リスト上すべてのデバイスを選択します。
Select none: リスト上すべてのデバイスを非選択にします。
 非選択
 選択

ボタン / 表記 説明
Device name デバイスの名前を表示します。
Device Firmware デバイスのファームウェアバージョンを表示します。
Dante Firmware デバイスのDanteファームウェアバージョンを表示します。
IP Address デバイスのIPアドレスを表示します。
FIRMWARE 
UPGRADE

デバイスのファームウェアアップグレードウィンドウを開きます。

RESET DEVICE デバイスを工場出荷時状態にリセットします。

4.4.6 Device Settings ウィンドウ

このウィンドウでは選択したデバイスの情報を表示します。
	• メニュー: Device > About Device
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ボタン / 表記 説明
[Device Name]: 
Current Firmware 
Version X.X

デバイスの現在のファームウェア情報を表示します。

Select Firmware ダウンロードされたファームウェアを選択します。
CANCEL ファームウェアアップグレードを実行せずウィンドウを閉じます。
UPGRADE NOW 選択したアップグレードファイルを適用しファームウェアをインストールします。
Upgrading 
Firmware to 
Version X.X

実行中のファームウェアアップグレードの進行状況が表示されます。

Firmware upgrade 
completed 
sucessfully

ファームウェアアップグレードが完了し、デバイスが再起動されます。

ボタン / 表記 説明
AUTOMATIC DHCPサーバーもしくはコンピューターよりローカルIPアドレスを取得します。
MANUAL 手入力でデバイスのIPアドレスを設定します。
IP Address AUTOMATIC が有効になっている場合DHCPもしくはコンピューターより取得したローカル

IPアドレスを表示します。
Static IP Address ユーザーが入力したIPアドレスを表示します。アドレスが有効な場合、チェックマークが付きま

す。
New Static IP 
Address

  アイコンをクリックすると新たにStatic IP Addressを入力することができます。

REBOOT NOW デバイスを再起動します。
CANCEL 変更を適用せずウィンドウを閉じます。
SET STATIC IP 
ADDRESS

Static IPをデバイスに適用します。

4.4.8 Firmware Upgrade ウィンドウ

デバイスのNeutrikファームウェアをアップグレードします。
	• メニュー: Device > Firmware Upgrade

4.4.7 Network Settings ウィンドウ
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ボタン / 表記 説明
Software Version DPRO Controller アプリのバージョンを表示します。
Version Date アプリのリリースされた日付を表示します。

4.4.9 About software ウィンドウ

アプリの情報を表示します。
	• メニュー: Help > About Software
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5  操作方法

5.1 ご使用前に
T DPROアダプターを開封します。
T デバイスの運搬や保管のため、パッケージは保存してください。
T パッケージやDPROアダプターに破損がないか確認します。
T デバイスやパッケージに破損がある場合は販売店にお知らせください。
T 破損したデバイスを使用しないでください。

5.2  DPROアダプターと接続デバイス
DPROアダプターは1Gbit/sツイス卜ペアイーサネットケーブル(CAT5e)でDante™﻿ネットワーク
に接続します。このネットワークケーブルを使用しデータ伝送と電源供給を行います。ケーブル長と
シールドの状況によりますが、イーサネットケーブルと電源ケーブルを並行しての設置は推奨しませ
ん。DPROアダプターの電源を切るには、PoEスイッチもしくはインジェクターを電源から抜く必要
があります。

DPROアダプターはスイッチからのPoE(48V)給電が必要です。スイッチにPoE機能がない場
合、PoEインジェクター(802.3afまたは802.3at対応)を直列接続する必要があります。

w 警告
聴覚障害の危険 !
他のデバイスを接続、同期するときに大きなノイズが発生する可能性があります。
T 接続を行う前に周辺機器で音声の出力をミュー卜してください。

w 警告
聴覚障害の危険 !
誤った接続をした場合、大きなノイズが発生する可能性があります。
T AES/EBU信号をチャンネル1に接続しないでください。
T XLRアウト1(ANA)に何も接続されていない場合、パワーアンプをはじめ、アナログ
デバイスをXLRアウト2(AES)に接続しないでください。

フロント リア
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	T 入出力デバイスを接続してください。﻿
アナログ信号:チャンネル1、2を使用﻿
AES信号:チャンネル2を使用
	T DPROアダプターをネットワークケーブルでPoEスイッチに接続してください。
	T PoE機能を搭載していないスイッチを使用する際はPoEインジェクターをご使用ください。
	�DPROアダプターがスイッチ、またはインジェクターからPoE受電すると、LEDが点灯します。.
	�DPROアダプターの準備は以上で完了です。
	�Dante™ Controllerで接続したいDante™ デバイスとの設定を行ってください。

5.2.1 PoE対応スイッチを使用した接続例

DPROアダプターはClass 2デバイスであることをPoEスイッチに伝え、正しい電力値での電
力供給を受けます。

5.2.2  PoE非対応スイッチを使用した接続例

オーディオ接続
ネットワーク接続

電源およびデータのリダンダンシーを確保するにはパッシブPoEインジェクターを2個使用します。
パッシブPoEインジェクターはディスカバリープロセスを使用しないため、プライマリー/セカンダ
リーの切り替え時に音声が途切れることがありません。PoEについて詳しくはページ41 7.2 PoE 
(Power over Ethernet) をご覧ください。

異なるPoEインジェクター(異なるメーカーなど)を使用しないでください。回路がショートしデ
バイスが使用できなくなることがあります。

プライマリー

プライマリー

プライマリー
プライマリー

プライマリー

オーディオ入力  オーディオ出力

オーディオ入力  オーディオ出力
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オーディオ接続
ネットワーク接続

5.3 使用例
5.3.1 リダンダントモード

リダンダントモードでは、2つの同一のDante™情報(オーディオ、クロックなど)が分離された各ネッ
トワークに送られることで、一方のネットワークに障害が起きても途切れることのない通信を可能に
します。 

5.3.2 スイッチドモード（デイジーチェーン）
スイッチドモードでは、いくつかのデバイスをデイジーチェーン接続することでチャンネル数を増やす
ことが可能です。この場合、電源供給にはパッシブPoEインジェクターが必要です。安全のため、ラ
バーカバー(NA-RC)を使用している場合は2台まで、非使用時は4台まで接続することが可能です。

デイジーチェーン接続をする場合はクラス非認証の
PoEスイッチを使用してください。
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5.4 DanteTM controller の設定
Dante™ controllerはDante™ ネットワーク上の設定やオーディオルーティングを簡単に行えるフリ
ーソフトウェアです。Dante™ Controllerは接続された機器を自動で検知し、ルーティングやチャン
ネルラベルをワンクリックで変更することが可能です。

Dante™ ControllerはAudinateのウェブサイトからダウンロード可能です。(www.audinate.com)

5.4.1  Dante™ ルーティング

	T Dante™ Controllerをダウンロードしインストールします。(https://www.audinate.com)
	T ネットワークケーブルを使用しコンビューターをスイッチ
に接続します。

	T Dante™ Controllerを起動します。
	T Routingダブを選択し、パッチを行う機器の+マークをク
リックします。
	T 接続したい各機器のチャンネルの交点の青い四角をク
リックします。

DPROアダプターはデフォルトでNA2DPROにMAC
アドレスの末尾6桁の英数字が付いたデバイスネー
ムでDante™Controller上に表示されます。このデバ
イス名はDante™ Controller上で任意のネームに変
更することができます

Dante™ Controllerはデバイス間のオーディオ信号の接続(
ルーティング)や、機器間のサブスクリプション設定を行うソフトウェアです。デバイスのコントロール
はDPRO Controller アプリより行います。

5.5 DPRO Controller アプリ
DPRO Controller アプリを使用すると、ユーザーはオーディオパラメーターの制御、デバイスの状態
のモニタリング、 プリセットの保存(Save)および呼び出し(Recall, Load)をすることが可能です。こ
のアプリは、WindowsおよびMac上で動作します。（タブレット端末には対応しておりません）

5.5.1  DPRO Controller アプリのダウンロードおよびインストール

DPRO Controller アプリは、WindowsおよびMac用が用意されています(無料)。インストー
ルする前にシステム要件を確認してください。

	T アプリはNeutrikウェブサイトよりダウンロードしてください。 www.neutrik.com/en/support/
downloads.

Windowsでのインストール
	T ダウンロードした.exeファイルを実行し手順に従います。
	�インストールウィザードが、エントリーをスタートメニューに、リンクをデスクトップに作成します。

OS Xでのインストール
	T ダウンロードした.dmgファイルを実行し手順に従います。
	�DPRO controller アプリがコンピューターにインストールされます。

DPRO Controller 
アプリアイコン
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5.5.2 デバイスとアプリの接続

	T 使用する環境に合わせてデバイスを正しく接続します。
	T DPRO Controller アプリを立ち上げます。
	�デバイスはDPRO Controller アプリに自動的に認識されます。

5.5.3 操作するデバイスの選択

	T MIC/LINEの切り替え:﻿
下部の MIC/LINE をクリックします。
	T -16 dBアッテネーションの切り替え: ﻿
PAD ボタンをクリックします。
	T ハイパスフィルターの切り替え:﻿
80Hz ボタンをクリックします。
	T ファンタムパワーの切り替え:﻿
+48V ボタンをクリックします。
	T ゲイン調整:﻿
ゲインノブをクリックしながら動かします。
	T インプットチャンネルのリンク/非リンク切り替え:﻿
Link/Unlink ボタンをクリックします。

1

	T 接続されたデバイスリスト（1）の中から任意のデバイスを選択します。
	�選択されたデバイスが緑のラインで表示されます。

5.5.4 インプットパラメーターの設定
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5.5.5 アウトプットパラメーターの設定

	T チャンネルのミュート:﻿
MUTE ボタンを押します。
	T アウトプットボリュームの調整:﻿
フェーダーをクリックしながら上下に動かします。
	T フェーダーを0に設定:﻿
Ctrl/Cmdキーを押しながらフェーダーをクリックします。
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5.5.6 プリセット

プリセットを使用すると、ユーザーはアプリに接続されているデバイスの設定を保存することができ
ます。

プリセットの作成
	T File > Create Preset... をクリック、もしくはショートカットコマンドCtrl/Cmd + N
	�Create a new preset ウィンドウが開きます。

	T ドロップダウンメニューよりInput ModeおよびOutput Mode(None, Analog, AES)を設定しま
す。
	T 各パラメーターを必要に応じて設定します。
	T SAVE PRESET ボタンをクリックするとプリセットを.dapファイル形式でお使いのコンピュータ
ーに保存します。
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プリセットの呼び出し
	T File > Load Preset... をクリック、もしくはショートカットコマンドCtrl/Cmd + L

	T コンピューター内から読み込む.dapファイルを選択し、Open ボタンをクリックします。
	� Load preset ウィンドウが開きます。この画面では選択したプリセットのプレビューが表示されます。

	T ドロップダウンメニューより使用するデバイスを選択します。
	T インプットおよびアウトプットへの接続がプリセット上のモードと一致するか確認します (ANA/AES)。
	T LOAD PRESET ボタンをクリックし、プリセットを呼び出します。 
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	�プリセットの呼び出しに失敗した場合、Load Preset mismatchスクリーンが開きます。

	T デバイスのインプット/アウトプットを確認します。﻿
アナログモードで使用する場合はチャンネル1および2を使用します。﻿
AESモードで使用する場合はチャンネル2を使用します。
	T もう一度プリセットを呼び出すか、違うプリセットを呼び出します。
	T 正しいプリセットが使用できない場合、新しいプリセットを作成します。

モードおよびスイッチに関しての詳細はページ11 4.3.3DPROのモードおよびスイッチ操作を
ご覧ください。
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プリセットの保存
	T CFile > Save As Preset... をクリック、もしくはショートカットコマンドCtrl/Cmd + S.

	T ファイル名を入力し Save ボタンをクリックします.

5.5.7 デバイスの識別

	T まず、識別したいデバイスを選択します。

Option 1:
	T メニューより Device > Identify Device の順にクリックします。
Option 2:
	T デバイスステータス画面右上のアイコン  をクリックします。 
Option 3:
	T ショートカットコマンド Ctrl/Cmd + Iを押します。

	�いずれかの操作で、デバイスのLEDが10秒間点滅します。
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5.5.8 デバイスのリセット

この操作はデバイスのすべての設定を消去します。リセットをしてもアプリとの接続は維持されます。
リセット方法は2通りあります。

ハードウェアリセット
ハードウェアリセットは以下のパラメーターをリセットします。
	• MIC入力を有効にしている場合:ゲイン=0ｄB、ハイパスフィルターおよびファンタムパワーはオフ
になります。
	• ネットワーク設定:工場出荷時(DHCP)状態に戻ります。
	• アウトプットのミュートが解除されます。

	T リアパネルのリセットボタンを5秒ほど押します。
	�デバイスがリセットされます。

ソフトウェアリセット

ソフトウェアリセットは以下のパラメーターをリセットします。
	• MIC入力を有効にしている場合:ゲイン=0ｄB、ハイパスフィルターおよびファンタムパワーはオフ
になります。
	• ネットワーク設定:工場出荷時(DHCP)状態に戻ります。
	• アウトプットのミュートが解除されます。

	T メニュー: Device > Reset Device…の順にクリックします。
	�Reset Devices ウィンドウが開きます。

	T リセットするデバイスを選択します。
	T RESET DEVICES ボタンをクリックします。
	�デバイスがリセットされます。

1
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5.5.9 ネットワーク設定

デバイスのIPアドレスは2つのモードに設定できます。

Automatic
DHCPもしくはコンピューターより取得したローカルIPアドレスを表示します。

Manual
ユーザーがIPアドレスを手動で設定します。

	T MANUAL モードを選択します。
	�新たなIPアドレスを入力するNew Static IP Addressラインが開きます。
	T  アイコンをクリックし設定したいIPアドレスを入力します。
	T SET STATIC IP ADDRESS ボタンをクリックします。
	T デバイスを再起動します:﻿
REBOOT NOW ボタンをクリックします。
	�設定したIPアドレスがデバイスに適用されます。
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5.5.10 ファームウェアアップグレード

DPRO Controllerではノイトリック製のファームウェアのみアップグレードします。Dante™フ
ァームウェアのアップグレードはDante™ Controllerより行ってください。

	T ファームウェアはNeutrik webサイトよりダウンロードします。 ﻿
www.neutrik.com/en/support/downloads.
	T DPRO Controller アプリ上でアップグレードするデバイスを選択します。

Option 1:
	T メニューより Device > Firmware Upgrade をクリックします。

Option 2:
	T デバイスステータス画面右上のアイコン  をクリックします。
	�Device Settings ウィンドウが開きます。

	T FIRMWARE UPGRADE ボタンをクリックします。
	�Firmware Upgrade ウィンドウが開きます。

	T Choose… ボタンをクリックし、ダウンロードしたアップグレードファイルを選択します。
	T UPGRADE NOW ボタンをクリックします。
	�ファームウェアアップグレードが開始します。

	�アップグレード中は実行中の進行状況が表示されます。
	�アップグレードが完了すると Firmware upgrade completed successfully と表示されます。
	�デバイスが再起動します。
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�アップグレード中は実行中の進行状況が表示されます。
�アップグレードが完了すると﻿Firmware﻿upgrade﻿completed﻿successfully﻿と表示されます。
�デバイスが再起動します。

5.6 アクセサリーの組み立て
w 注記
デバイスへのダメージを避けるため必ずNeutrik純正のねじを使用してください。

5.6.1﻿マウントブラケット

マウントブラケットはデバイスをフロアボックスやテーブル下に設置するために使用します。

内容品および
マウントブラケット組み立て手順

以下の工具を用意してください。
Oトルクスドライバー（T10）

ブラケット﻿×﻿2 固定用ねじ﻿×﻿2 トルクスねじ﻿×﻿2 スペーサー﻿×﻿2

1

T ラバープロテクションを外します。

2

T スペーサーとねじでブラケットを取り付けます。　　　﻿
（写真参照）

T ドライバーでねじを締めてください。
T 反対側も同じように取り付けます。

3 4

T 固定用ねじを取り付けます。（写真参照）
T 反対側も同じように取り付けます。

T ブラケットを必要に応じて動かします。
T 固定用ねじを締め、角度を固定します。
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5.6.2﻿ラックパネル

内容品

ラックパネル﻿×﻿1

1 2

T ラバープロテクションを外します。

T ラックパネルをデバイスに合わせます。
T 取り外したねじを使いラックパネルを取り付けます。

T フロントパネルの４つのねじを外します。

ラックパネルの組み立て手順

以下の工具を用意してください。
Oプラスドライバー

3
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1 2

3 4

5.6.3 トラスマウント

トラスマウントの組み立て手順

以下の工具を用意してください。
	Oプラスドライバー

内容品

プラスヘッドネジ × ４ 手締めネジ × ２ 落下防止フレーム ×１ マウントフレーム ×１ 

	T ラバープロテクションを外します。 	T 既存のネジを使用して落下防止フレームを取り付けます。

	T マウントフレームにデバイスを取り付けます。 	T 中心部を手締めねじでデバイスを固定します。
	T プラスヘッドネジで角度を決定します。

5

	T 完成
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6  ご使用後に

6.1 機器の取り外し
	T オーディオソース/シンクからデバイスを外してください。

6.2 運搬について
	T 製品を運搬する際は製品の梱包箱に製品と付属品を入れて運搬してください。

6.3 保管について
	T 製品を長期間使用しない際には接続している他の機器から製品を抜いてください。
	T 製品は乾燥した綺麗な場所で保管してください。
	T 汚れやホコリの多い場所、高温、多湿な場所を避けて保管してください。

6.4 清掃とお手入れ方法
	w 注記

不適切な清掃による製品破損の危険性!
	T 清掃前に接続している全ての他の機器を外してください。
	T 製品を水につけてはいけません。
	T 製品や付属品に水を吹きかけてはいけません。

	T 少し湿らせ低刺激洗剤をつけた柔らかい布で製品と付属品の表面を拭いてください
	T シンナーや研磨剤は使用しないでください。
	T 金属製の清掃用品を使用しないでください。 (例、硬い布や表面が粗いスポンジ)

6.5 メンテナンスと修理について
DPROアダプターはどの部品もお客様自身での整備や修理はできません。
	T DPROアダプター修理は本製品をお買い求めになった販売店にご相談下さい。

	T 定期的にカバー、コネクター、ケーブル、プラグの外観の破損を点検してください。
	T 破損を発見したら製品を使用しないでください。
	T 故障した機器は直ちに使用をやめてください。
	T 正常に動作しないケーブルや付属品は直ちに取り替えてください。
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6.6 廃棄
	T DPRO アダプターの廃棄についてはお住まいの自治体の取り決めに従って処理してく
ださい。
	T 電子機器やケーブル、プラグ、バッテリー等の電子付属品や部品を家庭ゴミで、処理
しないでください。

	T 外装や外装部品の廃棄についてはお住いの自治体の取り決めに従って処理してください。
	T お住いの自治体の取り決めに従ってプラスチック、金属等のリサイクル可能な部品を取り除いてく
ださい。
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7  付録

7.1 技術仕様

DanteTM 仕様
入出力 2 入力（ライン / マイクレベル、AES / EBU）﻿

2 出力（ライン / マイクレベル、AES / EBU）
サンプリング周波数 44.1 / 48 / 88.2 / 96 kHz
Bit depth 16, 24, 32 Bit
レイテンシー 0.25 ms （Dante）ユーザー設定による
イーサネット仕様 1000 BASE-TX （PoE対応）

電源仕様
消費電力 < 6W
使用電源 1.000 BASE-T PoEスイッチ （Power over Ethernet）または﻿

PoE インジェクター（IEEE 802.3af/at, class 2準拠)

アナログオーディオ入力
インプットノイズレベル -128 dBu（ゲイン = 67 dB ）Aウェイト
ゲイン（3 dB Steps） 0 – 67 dB
最大インプットレベル +24 dBu（PAD 使用時）

+8   dBu（PAD 非使用時）
インプットインピーダンス > 7.5kΩ（バランス）
周波数特性 20 Hz ・ 20 kHz (± 0.5 dB) 
ダイナミックレンジ > 112 dB, BW 22.4 kHz, A-weighted (input gain = min.)
Signal-to-noise ratio > 112 dB, BW 22.4 kHz, Aウェイト（インプットゲイン最小時）
THD + ノイズ < 0.005 % （20 Hz to 20 kHz, +4 dBu）
クロストーク -100dB （隣接インプット/アウトプットチャンネル、インプットゲイン最小時）

アナログオーディオ出力
アウトプットインピーダンス < 150 Ω
最大アウトプットレベル +24 dBu
アウトプット残留ノイズ -88 dBu, A-weighted
周波数特性 20 Hz ・ 20 kHz （± 0.5 dB） 
ダイナミックレンジ > 112 dB, BW 22.4kHz, Aウェイト
S / N比 > 112 dB, BW 22.4kHz, Aウェイト
THD + ノイズ < 0.005% （20 Hz to 20 kHz, +4 dBu)
クロストーク -100dB（隣接インプット / アウトプットチャンネル、インプットゲイン最小時）
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機器仕様 
質量 0.53 kg （ 1.17 lbs ）
寸法﻿
（ラバープロテクション含む）

L = 164 mm (6.4 inches)
B = 82 mm (3.2 inches)
H = 51 mm (2.0 inches)

寸法 ﻿
（ラバープロテクションなし）

L = 151 mm (5.9 inches)
B = 66 mm (2.6 inches)
H = 41 mm (1.6 inches)

使用環境 屋内
動作温度 0 °C ～ +50 °C
保管温度 –40 °C ～ +70 °C

アプリ動作要件
RAM 最小 2GB
ディスプレイ解像度 最小 1280 x 1024 px
オペレーティングシステム Windows 7 以降もしくは

Mac OS X 10.12 以降

7.1.1 位相について
シリアルナンバー830000～831294までのNA2-IO-DPROは入力側、出力側ともに極性が反転しています。(インプット・
アウトプット共に3番ホット)

アナログアウトはファームウェアアップデートVer.9.11で2番ホットになります。

信号が反転しても音質やタイミングに影響はありません。
ただし、特定のアプリケーションで問題がある場合は、お近くのノイトリック販売店にご相談ください。
ノイトリックではお客様に解決策をご提案させていただきます。
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7.2 PoE (Power over Ethernet)
PoEはPower over Ethernetの略で、CAT5eもしくは上位互換のケーブルを使用して電源およびデ
ータを同時に1つのケーブルで伝送する規格です。
以下の利点があります。
	• セットアップの簡便化
	• 100mまでのケーブルを使用可能
	• 電気工事の不要化
	• 既設のネットワーク設備を使用可能

7.2.1 定義

PD (Powered Device) - PSEに接続され、電力供給を受ける機器
PSE (Power Sourcing Equipment) – PD、ネットワークスイッチやインジェクターに電力を供給す
る機器

PSEの種類
In our case, we consider only following two types of PSE devices.
	• PoEスイッチ: PDへ電力供給をすることができるネットワークスイッチ。スイッチはPoEクラシフィ
ケーションを使用します。
	• PoEインジェクター: 一般的にポートが1つある、1つのPDへ電力供給する機器。クラシフィケーシ
ョンを使用するもの(アクティブ)と使用しないもの(パッシブ)があります。

上記のクラスとは、供給可能な最大電力量によります(以下の表をご覧ください)。

7.2.2 PoE規格

以下は IEEE 802.3 により定められた規格の一部です。
802.3 af – PoEクラス 0-3を定義 
802.3 at – 上記のクラスに加え、クラス4を定義。

7.2.3  PoEクラスおよびディスカバリープロセス

ディスカバリーとはPSEにおいてのプロセスであり、PDへの供給電力を確認します。PDとPSEが接
続されるとPSEがインパルス信号を送り、戻ってきた値に従って電源を供給します。PSEクラス(アク
ティブとも呼ぶ)はこのプロセスによって有効になります。ノークラスPSE(パッシブとも)は単なるパ
ワーサプライのように、ディスカバリープロセスがなく、一定の電流を常に流す方式です。

クラス タイプ 供給可能電力
1 802.3af 0.44 - 3.84 W

2 802.3af 3.84 - 6.49 W

3 802.3af 6.49 - 12.95 W

4 802.3at PoE+ 12.95 - 25.5 W


